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READ ME FIRST

VXIPC  800/700 SERIES FOR WINDOWS 95/NT
This document contains information to help you understand the 
components of your kit, determine where to start setting up your kit, 
and learn about the NI-VXI/VISA features.
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What Do You Have?
Your kit contains hardware, software, and documentation. You may al
have ordered some optional equipment or software.

Hardware
Your hardware includes either the VXIpc 800 Series or the VXIpc 700
Series controller, which you install in your VXI mainframe. You also 
receive the following accessories:

• 8 in. serial conversion cable 
(available for the VXIpc 800 Series only)

• Electromagnetic emissions kit

• AT-PS/2 cable

Software
Your VXIpc 800/700 Series controller comes with National Instrument
software already installed on its hard drive.

Windows 95 Kit
The Windows 95 kit contains the following software:

• Windows 95 CD-ROM

• NI-VXI/VISA for VXIpc 800/700 Series for Windows 95

• NI-488.2M Software for Windows 95

Windows NT Kit
The Windows NT kit contains the following software:

• Windows NT CD-ROM with boot disk

• NI-VXI/VISA for VXIpc 800/700 Series for Windows NT

• NI-488.2M Software for Windows NT

Printed Documentation
Aside from this document, your kit contains the following printed manua

• Getting Started with Your VXIpc 800/700 Series for Windows 95/N
contains an overview of the VXIpc hardware and the NI-VXI/VISA
software, guides you through setting up your kit, and helps you ge
started with application development. You can also use this manua
a reference for the hardware and software default settings, to find
answers for commonly asked questions, and for information on 
reinstalling the software, if necessary.
VXIpc 800/700 for Windows 95/NT 2 © National Instruments Corporation
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• The VXIpc 800 Series User Manual (for VXIpc 800 users) or the 
VXIpc 800/700 Series User Manual (for VXIpc 700 users) contains 
information on configuring and installing your VXIpc controller. You
may not require this manual if you are performing a simple hardwa
installation that uses the standard default settings. However, you 
should keep this manual handy in case you decide to try a differen
switch or jumper setting at a later time. The user manual also cont
information on BIOS, the front panel and connectors, LEDs, and 
system resources.

• Setup Information for Windows NT Users with VXI Embedded 
Controllers (for Windows NT users only)

• NI-488.2M documentation includes the following manuals:

– NI-488.2M User Manual for Windows 95 and Windows NT

– NI-488.2M Function Reference Manual for Win32

Acrobat (Online) Documentation
Your kit includes manuals that are not in printed form. These other 
manuals are available as Adobe Acrobat version 3.0 portable docume
format (PDF) files. You can view these manuals online, navigate throu
them, and print them from your computer. Adobe Acrobat Reader 3.0 
installed on your VXIpc controller’s hard drive. In the event of an upgrad
or if you need to reinstall the Reader, you can obtain the latest Adobe
Acrobat Reader directly from Adobe.

Adobe maintains a Bulletin Board Service (BBS), which you can use t
upload files to Adobe Technical Support and download certain Adobe fi
The number for the Adobe BBS is 206-623-6984. It is located in Seatt
Washington, which is in the Pacific time zone. If you live outside the 
United States or Canada, you are welcome to connect to the BBS, but
first want to try Adobe’s Web site (http://www.adobe.com/ ) or FTP 
site (ftp://ftp.adobe.com/ ), which may be accessible at a 
significantly lower connection cost.

The following list shows the path and filenames of the Acrobat manua
that are available on your hard drive (where Winxx  is either Win95 or 
WinNT):

• c:\NIVXI\Manuals\ NI-VXIUsersMan.pdf
This is the NI-VXI User Manual, which describes the features of the
NI-VXI software.

• c:\NIVXI\Manuals\ NI-VXIProgrammerMan.pdf
This is the NI-VXI Programmer Reference Manual, which describes in 
detail the VXI/VME function calls in the C/C++ and BASIC 
languages.
© National Instruments Corporation 3 VXIpc 800/700 for Windows 95/NT
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• c:\VXIpnp\Win xx \NIvisa\Manuals\ NI-VISAUsersMan.pdf

This is the NI-VISA User Manual, which describes how to program 
using VISA.

• c:\VXIpnp\Winxx\NIvisa\Manuals
\ NI-VISAProgrammersMan.pdf

This is the NI-VISA Programmer Reference Manual, which describes 
in detail the attributes, events, and operations you use in NI-VISA

• c:\Images\vxi8x7x\Manuals\ videosug.pdf

This is the TGUI96xx Video Accelerator Software User’s Guide 
provided by Trident Microsystems describing their TGUI9660 
software utility.

• c:\Images\vxi8x7x\Manuals\scsi.pdf

(VXIpc 800 users only) This is the SCSI Device Management 
System User’s Guide provided by NCR for their SDMS software. 
VXIpc 700 users do not have this file because the VXIpc 700 Ser
does not include SCSI.

Here are some tips on using PDF files efficiently:

• To view and print the online documentation, launch the Acrobat 
Reader and open the PDF documents. You can assemble your ow
printed documentation by printing out either the entire document o
only the sections relevant to your application.

• To use hypertext links, click on any entry in the table of contents to
jump directly to that topic’s page. You can jump to major sections 
within each manual quickly and easily by clicking on the bookmark
When you open your PDF documents, the bookmarks show. A 
bookmark with a triangle in front of it has bookmarks within it. To 
reveal the next level, click on the triangle. To collapse to a higher lev
click on the triangle.

• You can change the magnification of the documents either by selec
the magnifying glass tool in the toolbar and clicking anywhere on t
manual page or by using the various options in the View menu.

• You can quickly find and go to every occurrence of any word or phra
in the entire document. Select the Tools»Find... option and type in the 
key word or phrase you want to find.

• The PDF file assigns consecutive numbers to each page throughou
document and displays this page number in the lower-left corner of
Acrobat window. When you choose the View»Go To Page... option or 
are printing pages, you must use the page numbers in the lower-le
corner of the window, not the number displayed at the bottom cente
each manual page or listed in the contents and index. The numbe
shown in the bottom center of the page is for printed documents o
VXIpc 800/700 for Windows 95/NT 4 © National Instruments Corporation



 

te 

c 
, 

 
r. 
lar, 
ent 

 

re 
 to 
d 

he 
. 
.

ion 
 
A 
Available Options
You may have ordered the following optional software:

• LabVIEW Development software (CD-ROM). You also receive the
LabVIEW Configuration Disk so you can activate LabVIEW.

• LabWindows™/CVI Development software (CD-ROM). You also 
receive the LabWindows/CVI Configuration Disk so you can activa
LabWindows/CVI.

All of the software listed previously is already installed on your VXIpc 
controller’s hard drive, including LabVIEW and LabWindows/CVI. The 
National Instruments NI-DAQ software is also pre-installed on all VXIp
controllers to support the National Instruments data acquisition boards
including VXI-DAQ. A copy of all software media, excluding LabVIEW 
and LabWindows/CVI, is available in the c:\images  directory for 
immediate access.

Both LabVIEW and LabWindows/CVI integrate the VXI and VISA library
interfaces that are required to support your VXIpc embedded controlle
You also get hundreds of complete instrument drivers, which are modu
source-code programs that handle the communication with your instrum
to speed your application development.

Where Do You Start?

1. Compare your kit contents with the description in the preceding What 
Do You Have? section. Contact National Instruments regarding any
discrepancies.

2. If you ordered the LabVIEW or LabWindows/CVI software option, 
your kit includes either a LabVIEW or LabWindows/CVI 
configuration disk. Because both LabVIEW and LabWindows/CVI a
pre-installed on your hard drive in a nonfunctional mode, you need
insert the configuration disk when prompted to activate the installe
software.

Note: If you do not insert the configuration disks when prompted, Setup deletes t
pre-installed LabVIEW and LabWindows/CVI software from your hard drive
However, you can reinstall them from disk, as described in the next section

Otherwise, if you ordered a kit that does not contain the configurat
disks, install LabVIEW or LabWindows/CVI from disk if you want to
use either programming environment. Then reinstall the NI-VXI/VIS
software from disk or from the copy located in the c:\images  
© National Instruments Corporation 5 VXIpc 800/700 for Windows 95/NT
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directory. The NI-VXI/VISA installer updates necessary files in the
LabVIEW and LabWindows/CVI directories to ensure that the late
development files are being used.

3. If you require peripheral support for Ethernet, SCSI, PCMCIA, vide
or IDE, refer to the file c:\images\vxi8 x7x\drivers.txt . The 
drivers.txt  file contains the following information:

• Section 1 explains the procedure for recreating the hard drive
image should the operating system crash.

• Section 2 describes how to access the online documentation.

• Section 3 explains how to install the software drivers for the 
various peripherals on your VXIpc.

• Section 4 describes how to install NI-DAQ for use with system
including the National Instruments VXI, PCMCIA, PCI, or ISA 
data acquisition boards.

• Section 5 includes important information for Windows NT 4.0 
users.

4. After you finish setting up your system, refer to Chapter 3, Developing 
Your Application, in your getting started manual to learn how you ca
use your VXI/VME system and to ensure it is operating properly.

5. Please refer to the following files for important information that ma
affect your application program, including known issues and softwa
corrections with this release, and additional information relevant fo
NI-VXI and NI-VISA API development:

• c:\NIVXI\README.TXT  for NI-VXI information

• c:\VXIpnp\Win xx \README.TXT for NI-VISA information

You can also reference the National Instruments www.natinst.com  
or ftp.natinst.com  sites for driver updates, examples, and produ
news.

What Is NI-VXI?
The NI-VXI system-level software is the driver that controls your VXIp
and VXI/VME system. NI-VXI includes a Resource Manager, an 
interactive configuration and troubleshooting program, libraries of 
software routines for test and measurement (T&M) programming, 
interactive control programs for both NI-VXI and NI-VISA, and a loggin
utility your can use for debugging your applications. You can use this 
software to seamlessly program multiple-mainframe configurations an
have software compatibility across a variety of controller platforms.
VXIpc 800/700 for Windows 95/NT 6 © National Instruments Corporation
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What Is VISA?
VISA is a standard I/O Application Programming Interface (API) for 
instrumentation programming. VISA by itself does not provide 
instrumentation programming functionality for interfaces other than Ser
VISA is a high-level API that calls into system-level drivers. As an 
example, the NI-VISA implementation of VISA uses the NI-VXI 
system-level driver for National Instruments VXI controllers. If you are
GPIB or GPIB-VXI user, you must also install the NI-488.2 system-lev
driver for National Instruments GPIB controllers.

VISA can control VXI, PXI, GPIB, or Serial instruments, making the 
appropriate driver calls depending on the type of instrument being use
VISA uses the same operations to communicate with instruments 
regardless of the interface type. For example, the VISA command to w
an ASCII string to a message-based instrument is the same whether t
instrument is Serial, GPIB, or VXI. As a result, VISA gives you interfac
independence. This makes it easier to switch bus interfaces and mean
users who must program instruments for multiple interfaces need learn 
one API.

Another advantage of VISA is that it is an object-oriented API that will 
easily adapt to new instrumentation interfaces as they evolve, making
application migration to the new interfaces easy.

Because VISA is the industry standard for developing instrument drive
most instrument drivers currently written by National Instruments use 
VISA and therefore support Macintosh, Windows 3.x, Windows 95, 
Windows NT, Solaris 1, Solaris 2, and HP-UX, if the system-level drive
are available for that platform.

NI-VXI/VISA Release Notes
This section describes the new utilities and features in this release of 
NI-VXI/VISA for Windows 95/NT.

New Utilities
This release of NI-VXI/VISA for Windows 95/NT includes two new 
utilities to help you configure, develop, and debug your system quickly
T&M Explorer and NI Spy.

You can use T&M Explorer to view your entire T&M system and configu
various components. When you launch T&M Explorer, a list of your VX
GPIB, and Serial devices appears on your screen. To view the properti
© National Instruments Corporation 7 VXIpc 800/700 for Windows 95/NT
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each device (such as logical address, address space used, primary ad
right-click on the device in the list. When you view the properties of a 
National Instruments device, you can configure the hardware settings 
directly from the properties list.

T&M Explorer replaces many earlier utilities, such as VXIedit and 
VISAconf, and integrates with the NI-DAQ Configuration Utility 
(for VXI-DAQ instruments). T&M Explorer also has new features, such
as an option to run Resource Manager at startup, and troubleshooting
guide you through configuration conflicts and errors.

NI Spy tracks the calls your application makes to National Instruments
T&M drivers, including NI-VXI, NI-VISA, and NI-488.2. It highlights 
functions that return errors, so you can quickly determine which functio
failed during your development. NI Spy can also log your program’s ca
to these drivers, so you can check them for errors at your convenience

Supported Application Development Environments
This release of NI-VXI/VISA for Windows 95/NT supports the following
Application Development Environments (ADEs):

• LabVIEW version 4.x

• LabWindows/CVI version 4.x

• Borland C/C++ version 4.5.x

• Microsoft Visual C/C++ version 4.x, 5.x

• Microsoft Visual Basic version 4.x, 5.x

Note: Although NI-VXI and NI-VISA have been tested and found to work with thes
ADEs, other ADEs or higher versions of the ADEs listed above may also wo

New Features and Terminology
New functionality has been added to NI-VXI/VISA in four major areas 
exploit features in the MITE ASIC. These features are as follows:

• Window mapping

• MITE DMA

• Shared memory

• Remote controllers
VXIpc 800/700 for Windows 95/NT 8 © National Instruments Corporation
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Window Mapping
The MITE architecture allows much more flexibility in low-level mappin
of VXI address spaces. In particular, the CPU interface of the MITE ha
windows that can be dynamically resized and relocated from CPU spac
VXI space. The low-level functions have new extensions that reflect th
feature. Refer to the NI-VXI online help or the NI-VXI Programmer 
Reference Manual for information about these functions in NI-VXI. The 
NI-VISA online help and the NI-VISA Programmer Reference Manual 
cover this information for NI-VISA applications. As mentioned earlier i
this document, you can use the Acrobat Reader 3.0 to view and navig
through these manuals.

As in earlier versions of the drivers, the functions MapVXIAddress()  and 
viMapAddress()  check whether a window that can be shared already
maps to the desired address space and location. If so, they return a p
to that window. If the desired space is not already mapped, they set up a
MITE window to the VXI address and return a pointer to the new windo

The MapVXIAddressSize()  function is the standard mechanism for 
specifying how large a window the driver should map on a call to 
MapVXIAddress() . The default size of a mapped window when using 
NI-VXI is 64 KB. In VISA, you specify the window size directly in 
viMapAddress() . 

The success of this allocation depends on the availability of three fact

• Address space in the User Window

• Number of MITE windows

• Memory for allocating data structures for the map

Address Space
The VXIpc controller can decode any 32-bit address on the PCI bus a
VXI cycle, giving 4 GB of addressability, which can be used for window
on the VXIpc. The operating system or computer architecture may lim
which addresses can be assigned to the VXIpc. 

To change the address space, edit the user window size field in the PCI tab 
of the VXIpc Hardware Configuration settings in T&M Explorer. This 
setting limits the total amount of memory you can map with 
MapVXIAddress()  or viMapAddress() . If the User Window is disabled, 
the MapVXIAddress()  function returns NO_HARDWARE_SUPPORT (-1) .

The NI-VXI Programmer Reference Manual implies that the error code 
MAP_TIMEOUT (-8)  is returned when the window is in use. Because th
MITE-based products have multiple hardware windows of variable size
© National Instruments Corporation 9 VXIpc 800/700 for Windows 95/NT
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the meaning of this error has been modified. MapVXIAddress()  now 
returns the error code MAP_TIMEOUT (-8)  whenever there are not enough
resources to map the window.

For example, if you use MapVXIAddressSize()  and MapVXIAddress()  
to request a 1 MB window to A32 space, and you request a User Wind
in T&M Explorer of only 64 KB, MapVXIAddress()  returns the error 
code MAP_TIMEOUT because there are not enough resources to comple
the request.

Number of MITE Windows
The MITE has eight CPU windows. NI-VXI uses four of these windows
leaving four for user applications.

Memory for Allocating Data Structures
You need to have sufficient memory available to set up the necessary 
tables. If you request a very large window—hundreds of megabytes, f
example—you may run out of memory.

MITE DMA
The MITE has two DMA channels to improve the throughput of block 
transfers to and from the VXI system. The DMA channels can use vari
high-speed bus protocols, such as the following:

• VXI block 

• Burst mode (on the PCI bus)

• VME64 (on the VXI bus)

The DMA channels can transfer data between a VXI device and local 
memory, or between VXI devices. The DMA channel can handle 
contiguous or noncontiguous local memory. If it is handling noncontiguo
memory, it can perform scatter-gather operations on the noncontiguou
memory.

The VXImove()  and viMove XX()  functions automatically use appropriate
bus protocols and transfer types to efficiently perform the data transfe
specified in the function. You can also use configuration options in T&
Explorer to instruct the NI-VXI/VISA software to use DMA channels fo
particular types of operations and to designate what protocols the cha
should use. In addition, you can programmatically control which protoc
to use in NI-VXI. See the NI-VXI online help or the NI-VXI Programmer 
Reference Manual for complete descriptions of VXImove()  and other 
high-level functions. Notice that previously written NI-VXI and NI-VISA
code uses the DMA capabilities of the MITE without modification.
VXIpc 800/700 for Windows 95/NT 10 © National Instruments Corporation
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To take full advantage of the throughput of the DMA channels, you sho
perform 32-bit transfers where both the source and the destination are
longword aligned. If you need to transfer character data between device
different byte orders—for example, between a big-endian device and a
Intel 80x86-based Windows NT PC—transfer the data as longwords b
adjust the byte-ordering parameters in VXImove()  to get the correct data 
in the most efficient manner.

NI-VXI Examples:

/* Transferring 32-bit data to a big-endian A32 device */

VXImove(0x0, userBuffer, 0x3, deviceOffset, numDataPoints, 4);

/* Transferring 8-bit data to a big-endian A32 device */

VXImove(0x80, userBuffer, 0x3, deviceOffset, numDataPoints / 4, 4);

Shared Memory
In the Hardware Configuration  settings of the VXIpc 800/700 in T&M 
Explorer, you can share memory on your computer. Right click on any
the settings or consult the online help in T&M Explorer for more 
information. You can access shared memory on your computer using 
VXImemAlloc()  in NI-VXI and viMemAlloc()  in VISA.

Remote Controllers
This section applies to multiframe systems where you use interrupts, 
triggers, or utility bus signals.

Remote controllers, when configured to detect asynchronous events su
a VXI interrupt or VXI trigger, need to inform the local controller that suc
an asynchronous event has occurred. The remote controllers report th
events back to the local controller via a VXI IRQ line. This IRQ line is 
called the system IRQ line. You can use T&M Explorer to select which VXI
interrupt line the remote controller uses to report remote events to the l
controller. You need to map the system IRQ line back to the local contro
to receive remote controller interrupts. This mapping is performed 
automatically by the Resource Manager in the parent-side VXI-MXI-2 
controllers, but not in other mainframe extenders. You can map interru
through T&M Explorer, or with the MapVXIint()  function, which is 
described in the NI-VXI online help or the NI-VXI Programmer Reference
Manual.
© National Instruments Corporation 11 VXIpc 800/700 for Windows 95/NT



 

r. 

tem 
ler 

ed. 
ld 

ses 

 
.

ot 
 the 

 

The system IRQ line is treated differently than other IRQ lines used by
NI-VXI:

• The system IRQ line is always acknowledged by the Resource 
Manager (Logical Address 0).

• The system IRQ line cannot be disabled on the Resource Manage
Calling DisableVXIint()  on the system IRQ line does not disable it.

• Devices other than remote controllers can also interrupt on the sys
IRQ line, provided that the device at Logical Address 0 is the hand
for the interrupt.

• Routing the system IRQ line to the signal queue is not recommend
Because the system IRQ line cannot be disabled, this routing cou
lose interrupts.

Passing the value –1 as the logical address of a controller in NI-VXI cau
NI-VXI to select the local controller. Notice that on external controllers 
such as the PCI-MXI-2, –1 refers to the first remote controller in your 
system. This is to maintain compatibility with older systems where the
external controller needed an extender to assert and receive interrupts

Enhancements to the NI-VXI Software
The following sections describe the additional options beyond what is 
documented in the NI-VXI User Manual and the NI-VXI Programmer 
Reference Manual.

Compatibility
NI-VXI applications that follow the guidelines documented in the 
NI-VXI User Manual will work with NI-VXI for the VXIpc 800/700 Series.

System Configuration Functions
The InitVXIlibrary()  function has a new return value of 
INIT_RET_OK_RMERROR (2) . If this value is returned, it means “The 
NI-VXI library successfully initialized, but the Resource Manager has n
been run successfully.” Always run the Resource Manager before using
NI-VXI library.

Low-Level VXIbus Access Functions
Do not make any assumptions about the size and features of a window
returned from MapVXIAddress() . You should use GetWindowRange()  
to determine the size of a window.
VXIpc 800/700 for Windows 95/NT 12 © National Instruments Corporation
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The 32-bit value returned from GetContext()  and passed to 
SetContext()  has a new format. Applications that set the context bits
directly for use in SetContext()  may not be compatible with the new 
format for context. Because the MITE allows more flexible window 
mapping, extra bits have been added to this field to reflect these new 
features. Do not manipulate the context bits directly.

High-Level VXIbus Access Functions
For best performance, keep the following in mind when using VXImove() :

• Make sure your buffers are 32-bit aligned.

• Transfer 32-bit data whenever possible.

• Using VXI block access privileges significantly improves performan
to devices that are capable of accepting block transfers.

• VXImove()  must lock the user buffer in memory on virtual memory
systems, so locking the buffer yourself optimizes VXImove() .

• Because VXImove()  must build a scatter-gather list for the user buffe
on paged memory systems, using a contiguous buffer optimizes 
VXImove() .

VXImemAlloc()  returns 32-bit aligned, page-locked, contiguous buffer
which work efficiently with VXImove() , but only if the function returns 
MEM_OK (0) . A status of MEM_OK_USE_MEMCOPY (1)  means this buffer 
cannot be used directly with VXImove() .

VXImove()  can also move blocks of data to and from a single VXI addre
This is commonly referred to as FIFO mode. For more information refer to 
the NI-VXI Programmer Reference Manual.
© National Instruments Corporation 13 VXIpc 800/700 for Windows 95/NT
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